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1. Quick Installation Guide

The following is a Quick Guide to the installatiohAstral Reports For Dynamics
NAV.

Review prerequisites

Uninstall previous versions via the control panel
Remove the existing Add-In from Excel

Run the setup

Configure for SQL if required

Install the License

Test that Astral Reports can connect to Dynamic¥NA

Astral Reports Installation Version 2.00 Page 3 of 20

Guide
Copyright Astral Reports Limited - All rights resed



2. Prerequisites

2.1. Operating System and Office Software
Astral Reports can be installed successfully orfdthewing operating systems:

Windows 98 Second Edition Windows Vista
Windows Millennium Edition | Windows 7

Windows 2000 Windows Server 2003
Windows XP Windows Server 2008

Astral Reports has been designed to work succégsiulMicrosoft Office 2000
through to Microsoft Office 2007

2.2. Microsoft Dynamics NAV SDK (C/Front)

Prior to installation, Dynamics NAV C/Front mustibstalled. In earlier versions of
Dynamics NAV, this can be installed from the DynesnNAV CD by following the
instructions to install C/Front. In the most receatsions, C/Front is installed as part
of the SDK.

2.3. Microsoft Dynamics NAV License

C/Front requires a copy of the Dynamics NAV LiceRde to be stored into the
Client Directory within the Dynamics NAV applicationstallation directory.
Therefore, before installation, it is recommendwt this action be performed.

Furthermore, C/Front is a granule that must belmased from Microsoft via your
reseller. To see whether your license covers teeoti€/Front, select “License” from
the tools menu and look for Granule ID 1,800. liy@ave Microsoft Dynamics NAV
version 5.0 or later or you have updated your beeto the Business Ready Licensing
model, then CFRONT will be a part of your licence.

1,28 LSULM
1,808 C/FRONT
1,268 Test Integration
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3. Astral Reports Installation

3.1. Uninstall Previous Versions
Ensure that the Excel application is not open.

From the Windows Start button, select “All Programsd then “Astral Reports For
Dynamics NAV". Firstly select the “Remove Add Indan Excel” shortcut, and then
select the “Uninstall Astral Reports For Dynamic&\N shortcut.

fE Astral Reports For Navision ;'__'. Uninstall Astral Reports For Mavision
ﬁ- Internet Explorer @ Astral Reports Website

My Bluetooth Flaces Register Add In With Excel

g, Remote Assistance Remaove Add In From Excel

Alternatively, use “Add or Remove Programs” frone Windows Control Panel. Find
the “Astral Reports For Dynamics NAV” entry andcklithe “Remove” button.

The final step is to open the Microsoft Excel apgiion and remove the Add-In file
from the list of available Add-Ins. The “Remove AldFrom Excel” shortcut
mentioned above merely disables the Add In fildpies not actually remove it. To do
this, select Add-Ins from the Tools menu. Move ddha list using the arrow keys,
and when the “Astral Reports For Dynamics NAV” gn# reached, Excel will
prompt you with the following message:

Add-Ins available:

[] Analysis ToolPak
[] analysis ToolPak - VBA
|:| Astral Reports For Navision

Microsoft Excel

1L ) Cannot find add-in 'C:\Program Files\Astral Reports\Astral Reparts For Mavision\Astral Reports For Navision.xla'. Delete from list?

[ ves | [ Mo ]

Astral Reports For Navision

Click “Yes” to the message and then click “OK” dret‘Add-Ins” form. Then close
down Excel.
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3.2. Installing Astral Reports

If the installation application has been downloaftech the www.astralreports.co.uk
website as a zip file, unzip the contents of theth your local hard drive or shared
network drive.

Now double-click the “Setup.Exe” file to start timstallation.

Welcome to Astral Reports For Navision Setup program. This
program will install Astral Reports For Navision on your computer,

It is strongly recommended that you exit Windows programs before
running this Setup program.

Click Cancel to quit Setup and then dose any program you have
running. Click Mext to continue with this Setup program,

WARNING: This program is protected by copyright law and
international treaties. Unauthorized reproduction or distribution of
this program, or any portion of it, may result in severe dvil and
criminal penalties, and will be prosecuted to the maximum extent
possible under law.

woww, astralreports.co.uk [ Mext = l ’ Cancel

Follow the onscreen instructions to install AsR&lports, ensuring that you read the
license file before accepting it.

NOTE:

It is recommended that the default installatiorataan isnot changed. Since Astral
Reports allows you to include custom built funciamthin a spreadsheet, the
function will be referencing a function that is tamed in another file.

Should the spreadsheet be opened by another ussa, Hll look for the function
within the same file in the same location on therige.

If you do wish to install the functions to an aitate location, all other installs should
use the same alternative location.

After the above procedures have been followed,aA&eports will be ready for use.
To check that the installation was successful, dgemosoft Excel. You should see
the “Astral” drop down menu.
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Menu Commands

3.3. Changing the Language

Astral Reports installs with the English languag&IG) as a default. To change the

language, select “Set Language” from the AstraldrispOptions menu item.

Home Insert Page Layout Formulas Data

|- Astral *]

Database 2

Recalculate

Remove Formula

| Hide Rows o] Jx
| 4 Get Table b e P e E F
1| Options... k Crilldown Fields Selection -
2
. About Set Database Format to Mative 1
a set gnguage [l
5 Reset All Settings
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Language Code English - Urited Kingdom [ENG]

English - United Kingdom [EMG]
English - United States [ENU] h
Firmizh [FIM]

French - Belgium [FRE]

French - France [FRA]

German - Austna [DEA]

German - Germany [DEU]
German - Switzerland [DES] b

»

RN

(] | Help

Select your preferred language from the drop dastrahd then select “OK”. After
selecting OK, the menu captions and form captiofisupdate, and the Help File
automatically linked to the correct Help File.

3.4. Security

Each user will need to have a base level of peramssn each company. These
permissions are simply to allow C/Front the abildyevaluate whether the user has
further permissions for the desired data.

The simplest method of configuring the Dynamics N#@aturity is to create a new
“Role” called “Astral”

28 Roles
Role ID Mame
: ADCS ALL ADCS User g
| ADCS SETUP ADCS Set-up
ALL All users B
| pasmAL lAstelRepors |
| BASETUP Business Analytics setup
| BM-SETUP Business Notifications setup
| BN-LISER Business Motifications user
| CHANGELOG-DELETE Delete Chanage Log Entries
CHANGELOG-SETUP Setup Change Log
| CHANGELOG-VIEW View Change Log Entries
| |CP-M5GDISP CP Message Dispatcher (Basic)
| CP-PERIODIC CP Periodic Activities
| CP-SETUP CP Setup
FA-FINED ASSET Read fixed assets and entries el
[ Role - | Help |
Within this Role, permissions are required for éhitems.
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The “Object” Table Data allows Astral Reports t@kesate whether the user has
permissions for a certain table within the requitechpany, and the “Company”
Table Data allows Astral Reports to build a dropddist of companies for use when
retrieving data from Dynamics NAV.

3.5. Configuring Fields For Drilldown

On first connection, default drilldown fields arenéigured. These can be changed at
any time by opening the “Drilldown Fields Selectidorm.

| Astral *

Database k

Recalculate

Femove Formula

| Hide Rows . Jx |
et Table » L E D E F
Options... kol Drilldown Fields Selection
Eabase Format to Mative

About et

Set Language

Reset All Settings

nlw|e|ws =]

Before opening the form, a connection to Dynamiéd/Nnust have been established.

-
Astral Reports For Navision,

§ l} There is no active connection to Navision. Please connect and retry.
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Once a connection has been established, the uselochle-click the various
drilldown enabled tables and double-click on tledd$ to toggle the field on/off.

Once finished, clicking “Save” will store the rerpd field combinations to the
computers registry.
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4. Testing Dynamics NAV C/Front connection

4.1. Establishing Dynamics NAV Connection Method

The simplest method to establish how you connebBlyttamics NAV is from within
the Dynamics NAV application itself. Open up DynasmNAV as normal, and when
you are connected to your Dynamics NAV Databadecst-ile” and then
“Database”.

For installations that use the native databasedgrpou will be displayed with a
three tabbed form, and for SQL installations yoll s&@e a two tabbed form.

Native Installations

If the Connection is shown as “Local”, you will bt look at the database tab and
make a note of the entry within the “Database Nafiedd. If the Connection is
shown as “Server”, make a note of the entry in‘8erver Name” field.

SOL Installation
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If the Connection is shown as SQL, you will needni@ke a note of the “Server
Name” and the “Database Name” shown on the Datdhhase

4.2. Configuring Astral Reports to use SQL

By default, Astral Reports is configured for MicofisDynamics NAV’s native
database format. If you have established that @le @atabase format is being used,
you will need to perform one additional configuoatistep prior to connection.

From the “Astral” menu within Excel, select “Opts&irand then “Set Database
Format to SQL".

Select “Yes” at the confirmation dialog that isplasyed.

At this stage you are informed that Excel mustlbsed and then reopened for the
changes to take effect. After reopening you willentnat the “Set Database Format to
SQL” menu item has changed to “Set Database Faordative”
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4.3. Installing the Astral Reports License File

If you have obtained an Astral Reports licensetfi is linked to your own
Dynamics NAV license file, or wish to use a demaaisbdn license, you can do so by
selecting the “License” button from the “About” for

This will initially display an entry screen, butef browsing for the license file it will
display it within the form.
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It is suggested that the license be placed inté\gieal Reports installation directory,
or within a shared folder on the network.

NOTE:
Each Astral Reports license file is linked to a Byncs NAV license file via the

“Dynamics NAV License No.”
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4.4, Making the first connection

At this stage, you are ready to test your connadtiom Astral Reports to Dynamics
NAV.

From the “Astral” menu within Excel, select “Dataled and then “Open”.

Enter the connection information obtained from phecedures above, and select NT
Authentication if you normally connect to DynamMAV without requiring a User
name and Password.

Click “Open” and if no error message is displayastral Reports has successfully
connected to Dynamics NAV.
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5. Using the Custom Functions

Astral Reports uses the concept of providing furithat are based on Dynamics
NAV’s SIFT technology. Each function utilises titéshnology, and therefore
provides a “highly tuned”, predetermined structiamreextracting information from
the system.

To see the extensive list of functions, click oa titop down box that is next to the
“Auto Sum” icon on the toolbar, and select “MorenkEtions”.

Alternatively, go to the Formulas menu and selétsért Function”.
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Now, from the “Insert Function” form, change theat€gory” to “Astral Reports” and
you will be displayed with a complete list of thenttions.
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6. Help

The “Help File” that is included as part of thetadktion is the best source of
information relating to the functions that are navailable to you for use within
Excel. This help file can be opened from each “@d®eports” form that is displayed,
and additionally, from the “Help on this functiolirik which can be found at the
bottom left of Excel’s standard “Insert Functiowtn.

The following are examples of how the Help File banaccessed.

From the “Insert Function” form

From the “About” form

Astral Reports Installation Version 2.00 Page 18 of 20
Guide
Copyright Astral Reports Limited - All rights resed



From the “Database Open” form
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7. Troubleshooting
The following are known issues relating to conmegC/Front to Dynamics NAV.

Incorrect Version of C/Front
The installed version of C/Front must corresponth&installed version of Dynamics
NAV. The safest method here is to install C/Freatrf your original Dynamics NAV
CD. However, some CDs for older versions of DynaN&V (Version 2.01 for
example) incorrectly shipped the wrong version &#rGént.

If you are faced with this issue, contact your Hes¢o provide you with the correct
version for your Dynamics NAV installation.

The Database File is already in use
If testing Astral Reports for demonstration purgs®u may have the Dynamics
NAV application open with a direct connection ttmeal database. Since this type of
connection a single user only connection, Astrgdd®es will not be able to connect
until Dynamics NAV is closed. However, the functomay still be used, but they
will return “#NC#”, meaning “No Connection”.
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